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UTILI1ZZO

Il kit AA1397/48 consente di analizzare contemporaneamente sei diverse mutazioni e
polimorfismi coinvolti nelle trombosi arteriose e venose profonde: Fattore V G1691A, Fattore V
H1299R, Fattore Il G20210A, MTHFR C677T, MTHFR A1298C, PAI-1 4G/5G. La genotipizzazione
viene effettuata mediante amplificazione delle sequenze bersaglio e analisi delle curve di melting.

Tale dispositivo € compatibile con lo strumento CFX (BioRad) e con i sistemi di estrazione del DNA
su colonnina (cod. NLM AA1001) e con biglie magnetiche (AA1319/96). Sono compatibili anche i
sistemi automatici di estrazione Maxwell (cod NLM AA1038) e MagCore (cod NLM AA1185).

Gli enzimi necessari sono inclusi nel kit.

INTRODUZIONE

Le trombosi venose sono tra le tre malattie cardiovascolari piu comuni e coinvolgono circa 1
individuo su 1000 ogni anno. Il rischio trombotico & determinato sia da fattori ambientali (eta,
interventi chirurgici, gravidanza, contraccezione orale) sia da una predisposizione genetica. Ad
esempio la mutazione G>A in posizione 1691 nel gene per il fattore di coagulazione V (FV
Leiden — R506Q) é stata trovata con un’alta frequenza (20-60%) nei pazienti affetti da trombosi.
Altre mutazioni nel gene del Fattore V, come ad esempio I'aplotipo HR2 (H1299R) che comporta
la sostituzione A>G al nucleotide 4070, sono causa di trombosi soprattutto se associate alla
mutazione R506Q. Mutazioni puntiformi a carico della metilentetraidrofolato reduttasi (MTHFR
C677T e A1298C) e della regione 3’ non tradotta del gene della protrombina (Fattore I
G20210A) sono state associate rispettivamente ad una riduzione dell’attivita enzimatica della
MTHFR e ad un elevato livello di protrombina nel plasma. Ciascuna di queste varianti, in
associazione alla variante Leiden del Fattore V, determina un aumento del rischio relativo al
tromboembolismo venoso.

Tra i potenziali marcatori genetici di rischio cardiovascolare € stato individuato anche il gene
PAI-1 (Inibitore dell’Attivazione del Plasminogeno - tipo 1) che svolge un ruolo critico nella
regolazione della fibrinolisi intravascolare. La presenza di una sequenza 4G (invece che 5G)
allinterno della regione del promotore & stata associata ad un aumento del rischio di
tromboembolismo venoso.
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PRINCIPIO DEL TEST

Il test si basa sulla tecnica di Real Time PCR in cui il DNA estratto viene amplificato in presenza di
una sonda complementare alla regione che comprende la mutazione: la sonda & marcata in 5° con
uno specifico fluoroforo mentre in 3’ € legato un quencher. Quando la sonda non é legata al DNA la
fluorescenza emessa dal fluoroforo viene smorzata dal quencher: in assenza del bersaglio non
awviene quindi nessuna emissione di fluorescenza. Quando pero la sonda si appaia al DNA, il
fluoroforo non e piu smorzato dal quencher e, in presenza di una fonte luminosa, si ha emissione di
fluorescenza ad una specifica lunghezza d’onda.

Le sonde permettono di identificare varianti della sequenza bersaglio mediante la curva di
dissociazione (melting curve), sottoponendo I'amplificato ad una rampa crescente di temperatura con
conseguente distacco delle sonde dal DNA. Se la sonda € complementare al filamento mutato di
DNA, l'ibridazione tra i due sara piu stabile rispetto al duplex tra la sonda medesima ed il filamento
che non porta la mutazione (single point mismatch), con conseguente picco di dissociazione ad una
temperatura piu elevata. Se viceversa la sonda € complementare al filamento che non porta la
mutazione, sara il picco wild type ad avere il picco di dissociazione alla temperatura piu elevata.
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Mediante I'analisi della curva di melting si possono pertanto distinguere i tre genotipi in base alla
posizione dei picchi; picchi singoli a due diverse temperature per i campioni omozigoti
(normale/mutato) e doppio picco per i campioni eterozigoti.

L’analisi comprende due fasi successive:
1. isolamento del DNA genomico

2. amplificazione e rivelazione delle sequenze bersaglio mediante Real Time PCR
Le regioni dei geni MTHFR, FV, Fll e PAI-1 che comprendono le rispettive mutazioni di interesse
vengono co-amplificate in un’unica reazione di Real Time PCR utilizzando primer opportunamente
selezionati.

Le singole varianti sono analizzate tramite I'utilizzo di sonde specifiche legate a fluorofori diversi:

- MTHFR C677T: la sonda specifica € legata al fluoroforo FAM
-  MTHFR A1298C: la sonda specifica € legata al fluoroforo JOE
- PAI-1 4G/5G: la sonda specifica e legata al fluoroforo CY5

- FV H1299R: la sonda specifica € legata al fluoroforo CY5.5

- FV G1691A: la sonda specifica € legata al fluoroforo ROX

- FIl G20210A: la sonda specifica € legata al fluoroforo ROX

Lo strumento CFX (BioRad) comprende in un singolo strumento un termociclatore ed un dispositivo
per la rilevazione della fluorescenza. Un computer collegato al sistema raccoglie i dati di
fluorescenza che vengono visualizzati in un grafico mediate un apposito software. L’analisi dei dati
viene effettuata tramite la rielaborazione dei dati effettuata dal software Real Gene (cod NLM
DO0022).

COMPOSIZIONE DEL PRODOTTO (conservare a -25/-15°C)

REAGENTI QUANTITA’ | N° VIAL

Mix 1 CVDB6, tappo trasparente 1ml 1

Mix 2 CVD6, tappo blu S
1 A

Soluzione contenente oligonucleotidi 160 ul 1\\

Mix 3 CVD6, tappo bianco 18 ul 1

DNA polimerasi (5U/ul), tappo arancione 36 ul 1

STABILITA E CONSERVAZIONE

e Tutti i reagenti sono stabili fino alla data di scadenza riportata sull’etichetta se conservati alla
temperatura indicata (-25/-15°C).

e Scongelare la mix di amplificazione in ghiaccio o a +2/+8°C.

e Le sonde contenute nella Mix 2 CVD6 sono fotosensibili: evitare I'esposizione prolungata alla
luce.

e La Master Mix va utilizzata subito dopo la preparazione; dopo averla dispensata nelle provette
da PCR, quella rimanente va scartata. Evitare prolungate esposizioni alla luce.

e Mantenere in ghiaccio tutti i reagenti per I'amplificazione durante l'esecuzione dellintera
procedura.

e Al termine di ogni seduta riporre i reagenti alla rispettiva temperatura di conservazione.
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PRECAUZIONI

La procedura va eseguita da personale competente, utilizzando le buone pratiche di laboratorio
ed i comuni dispositivi di protezione individuale.

Utilizzare puntali con filtro per evitare la contaminazione delle pipette.
Eliminare il materiale monouso utilizzato, i guanti indossati e tutti i reattivi come rifiuti speciali.
Non mangiare, bere, fumare o applicare cosmetici nelle aree preposte all’esecuzione del test.

Se vi & esposizione di occhi, cute 0 mucose alle sostanze utilizzate, lavare abbondantemente con
acqua e contattare al piu presto un medico.

Non utilizzare reagenti scaduti.
Non mischiare reagenti di lotti diversi.

Tenere i reagenti separati da possibili acidi nucleici contaminanti (campioni e prodotti di
amplificazione).

Evitare ripetuti scongelamenti delle mix.

Si consiglia di eseguire I'analisi in tre zone separate.

- Zona 1: pre-PCR (manipolazione dei campioni ed estrazione).

- Zona 2: preparazione della Master Mix.

- Zona 3: post PCR (Real Time PCR).

Non utilizzare il kit se la scatola & danneggiata; contattare il fornitore.

E’ opportuno assicurare una temperatura il piu possibile costante ed uniforme in laboratorio ed
evitare di posizionare gli strumenti in prossimita di fonti di calore/raffreddamento che possano
comprometterne il corretto funzionamento.

MATERIALE NECESSARIO MA NON FORNITO
ZONA 1

Kit di estrazione per DNA

Cappa a flusso laminare verticale

Set dedicato di pipette a volume variabile
Puntali con filtro monouso

ZONA 2

Cappa a flusso laminare verticale

Set dedicato di pipette a volume variabile
Puntali con filtro monouso

Strip o piastre da 0,2 ml per Real Time PCR

ZONA 3

Strumento per amplificazione in Real Time: CFX Bio-Rad a 5 canali con Software abbinato
Software interpretativo Real Gene (cod. NLM DO022)
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PROCEDIMENTO
ISOLAMENTO DEL DNA

Kit di estrazione da utilizzare: cod. NLM AA1001 (estrazione manuale su colonnina) oppure
AA1319/96 (estrazione automatica con Janus — Perkin Elmer). Sono compatibili anche i sistemi
automatici di estrazione Maxwell (cod NLM AA1038) e MagCore (cod NLM AA1185).

Usare solo EDTA o citrato come anticoagulanti, non eparina. E’ possibile utilizzare sangue fresco o
conservato a +2/+8°C per non piu di 2 giorni oppure conservato a -25/-15°C.

AMPLIFICAZIONE
Attenzione

o L'utilizzo di campioni di sangue o di estratti che abbiano subito ripetuti scongelamenti o
un’impropria conservazione puod pregiudicare I'esito positivo del test

e Utilizzare solo provette da Real Time PCR specifiche per lo strumento in uso

e Impostare il profilo termico prima di preparare le mix

¢ Mantenere le provette e tutti i reagenti per 'amplificazione in ghiaccio durante I'esecuzione
dell’'intera procedura

Preparazione della Master Mix

Reagenti \Qogﬁn?ﬁ)ﬁgr
Mix 1 CVD6, tappo trasparente 18,8 ul
Mix 2 CVD6, tappo blu 2,85 ul
Mix 3 CVD6, tappo bianco 0,25 pl
DNA polimerasi, tappo arancione 0,6 ul

e Preparare le Master Mix per il numero di campioni estratti + 1 volume (per n < 10) o + 2 volumi
(per n >10)

e Miscelare delicatamente e dispensare 22,5 pl di Master Mix nelle strip con provette da 0,2 ml.
Scartare la Master Mix avanzata

e Aggiungere in ciascuna provetta 2,5 ul del rispettivo DNA (la concentrazione del DNA estratto
da analizzare deve essere di circa 20-60 ng/pul)
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SETUP DELLA CORSA

Accendere il PC e lo strumento Real Time

Aprire il Programma “Bio-Rad CFX Manager Software” e selezionare “Create new run”. Nella
finestra selezionare il modello di strumento utilizzato e cliccare “OK”; si apre il “Run Setup”

E’ possibile creare un nuovo protocollo o selezionarne/modificarne uno pre-esistente

Per ripetere una corsa: aprire la corsa desiderata e cliccare su “File - Repeat Run”

Creazione di un nuovo protocollo

“File> New Protocol”

Si apre la finestra “Protocol Editor - new”

Inserire il volume di reazione (25 ul) nel “Sample Volume” box

Utilizzare “Insert Step” sulla sinistra della finestra per inserire il seguente profilo termico (&
possibile modificare le temperature e i tempi direttamente sul grafico o nel testo in basso con un
doppio click):

1 25,0° C for 10:00 min
2 95,0° C for 2:00 min
3 95,0° C for 0:15 sec
4 60,0° C for 0:50 sec
5 GOTO 3, 44 more times
6 95,0° C for 00:45 sec
7 37,0° C for 00:30 sec
8 Melt Curve 37,0 to 75,0° C, increment 0,5° C
for 0:05 sec + Plate Read
END
1 280 C for 10:00
P 950 C for 2:00
— 3 850 C for 015
4 600 C for 0RO
— & GOTO 3, 44 moretimes
& 950 C for 0:45
7 370 C for 0:30

[e]

Melt Curve 370 to 750 C,increment 05 C,
for 0:05 + Plate Read
END

Cliccare OK. Salvare il nuovo protocollo.

SETUP DELLA PIASTRA

Selezionare “plate” nella finestra “Run setup™ & possibile creare una piastra nuova o
selezionarne/modificarne una pre-esistente.

Creazione di una nuova piastra

“File> New Plate”

Si apre una nuova finestra “Plate Editor — new”

In “Scan Mode” selezionare “All channels”

Cliccare “Select Fluorophores” e selezionare FAM, JOE, ROX, Cy5, Cy5.5

Selezionare i pozzetti della piastra in cui verranno posizionati i campioni.

Selezionare in “Sample Type - Unknown

Selezionare “Target Name” e spuntare la casella “Load” per inserire i fluorofori. Nominare
esattamente i target come indicato nella Tabella 1
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Target Fluoroforo
Ce77T FAM
A1298C JOE
FV Leiden e FlI ROX
PAI-1 4G/5G Cy5
FV HR2 Cy5.5

Tabella 1. Impostazione del Target Name

Selezionare una casella alla volta e inserire il nome del campione nel campo “Sample Name”:
quindi spuntare la casella “Load”
Cliccare “OK”. Salvare la nuova piastra (Figura 1)

File Settings Editing Tools

100%

~ | 8 Scan Mode | All Channels

T) Well Groups... | 6] Trace Styles... | == Spreadsheet View/Importer

?

i@ Plate Loading Guide

2 3

b

&

8 ]

Unk Unk Unlc Unk Unk Unk
A1298C A1298C A1298C A1298C A1298C A1298C
PAI-145/55 | PAI-14G/5G | PAF14G/SG | PAI-14G/5G | PAI-14G/36 | PAI-14G/5G
FV HR2 FV HRZ AU HR2 FV HR2 FV HR2 FV HR2
& B c D E E

Figura 1. Set up della piastra

SELEZIONE E MODIFICA DI UN PROTOCOLLO O DI UNA PIASTRA ESISTENTE

| ! J; Select Fuorophores... |

Sample Type m
Load Target Name

V| FAM CE77T -
V] joe A1298C -
V| ROX FVleidene F +
V| Cys FAI-14G/5G -
V| Cy55 FV HR2 -
Load Sample Name

i F -

Load Replicate #
1 -

| Replicate Series |

‘T:'Eﬂ Experiment Settings... |
| 3/§ Clear Replicate # |

| —/a_tj Clear Wells |

Exclude Wells in Analysis

Se si desidera importare un profilo termico (*.prcl) o una piastra (*.pltd) precedentemente salvati nel
PC, selezionare rispettivamente “File > Open Protocol” o “File2 Open Plate”. E’ eventualmente
possibile modificare il protocollo o la piastra richiamati e salvare le modifiche introdotte

AVVIO DELLA SEDUTA

Selezionare “Start Run” nella finestra “Run Setup”. Lo strumento € pronto per iniziare la corsa

Preparare la piastra/strip con campioni € mix

Aprire il coperchio, posizionare la piastra/strip nello strumento e chiudere

Selezionare “Start Run” per iniziare

Non modificare il home con cui di default viene salvata la seduta dal CFX. Le informazioni
contenute sono necessarie per la tracciabilita delle sedute in quanto vengono riportate data e
ora di inizio della corsa
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ANALISI DEI DATI

- Alla fine della corsa si apre automaticamente la finestra “Data Analysis”

- Selezionare “Melt Curve”: si apre una nuova finestra dove vengono visualizzati i grafici della
seduta. Il grafico a sinistra mostra il dato grezzo della curva di melting (RFU), il grafico a

destra mostra I'analisi —d(RFU)/dT con i picchi delle curve di melting
- Selezionare Peak Type > Positive

rumore di fondo e/o eventuali picchi aspecifici (rif. Figura 2a e 2b)

- Selezionare “Melt Curve Data” e analizzare i picchi di melting ottenuti per ogni campione

utilizzando la Tabella di seguito riportata.

Impostare manualmente la threshold corretta per ogni singolo fattore in modo da eliminare il

Fattore Fluoroforo Tm1 Tm2 Tm 1+ Tm 2
[°C] [°C] Genotipo [°C] [°C] Genotipo Genotipo
cofon | U | 63 2 | wiavpe | 685 sz | ORI cougoe
Fy Leiden ROX 48 | :2 | widype | 565 | x2 | Omozgote Eterozigote
e | oS 48 w2 | wiee | S92 R ceongos
hé'gl;'?F_IEi EAM 60 +2 wild type 51 +2 Onr:](l)ﬁ;gzgte Eterozigote
(AI,DGA/I5(13) cvs 58 +2 Omcizci;gote 64 +2 Omoszci;gote Eterozigote 4G/5G

Tabella 2. Tabella interpretativa per la genotipizzazione dei campioni

C—> ATTENZIONE

Per modificare manualmente la Threshold, cliccare sul grafico Melt Peak e spostare la soglia fino a

rimuovere il rumore di fondo.

Melt Peak

g0 Lo

100 A oveeereiions

-d(RFU)/dT

50 +-

L1

s0 L. 4t .
|

40 50

60 70
Temperature, Celsius

Melt Peak

]

-d(RFU)/dT

£\ —

I L
50 60
Temperature, Celsius

+
70

Figura 2a. Grafico per Fattore V H1299R
con threshold impostata manualmente
per eliminare il rumore di fondo.

Figura 2b. Grafico per MTHFR C677T con
threshold impostata manualmente per
eliminare il rumore di fondo.

Per la refertazione utilizzare il programma RealGene (cod. NLM DO022).
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CARATTERISTICHE PRESTAZIONALI

Sensibilita analitica

La sensibilita analitica del kit “CVvD6 Multiplex Real Time”, espressa come la quantita minima di
marcatore bersaglio che puo essere esattamente rilevata (Probabilita > 99%), € pari a 1 ng/pl di DNA
(equivalente a 2.5 ng a reazione) ed e stata valutata analizzando diluizioni seriali di DNA di tre diversi
campioni estratti con AA1001 e processati come da metodica.

Sensibilita diagnostica

La sensibilita diagnostica del kit “CVD6 Multiplex Real Time” é stata valutata analizzando 47
campioni a genotipo noto. Il kit ha permesso di discriminarli tutti in maniera corretta, pertanto la
sensibilita diagnostica del dispositivo & pari al 100%.

Specificita diagnostica

La specificita del kit “CVvD6 Multiplex Real Time” & stata determinata testando 47 campioni a
genotipo noto. Non sono stati ottenuti risultati falsi positivi. In accordo con tali dati la specificita del kit
e pari al 100%.

Riproducibilita

Riproducibilita intrasaggio

La riproducibilita intrasaggio & stata valutata testando 3 diversi campioni in 3 replicati nella stessa
seduta.

Riproducibilita intersaggio
La riproducibilita intersaggio é stata valutata analizzando 3 diversi campioni in sedute diverse
effettuate da operatori diversi.

In base ai risultati ottenuti la riproducibilita & del 100%.
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INTENDED USE

The AA1397/48 kit allows the simultaneous analysis of six different mutations and polymorphisms
involved in deep venous and arterial thrombosis: Factor V G1691A, Factor V H1299R, Factor I
G20210A, MTHFR C677T, MTHFR A1298C, PAI-1 4G /5G. Genotyping is performed by amplification
of target sequences and melting curves analysis.

This device is compatible with the CFX (BioRad) instrument, column based DNA extraction systems
(NLM code AA1001) and with magnetic beads (NLM code AA1319/96). Automatic extraction systems
Maxwell (NLM code AA1038) and MagCore (NLM code AA1185) are also compatible.

The necessary enzymes are included in the Kkit.

INTRODUCTION

Venous thrombosis is among the three most common cardiovascular diseases and involves
approximately 1 in 1000 individuals each year. Thrombotic risk is due to both environmental factors
(age, surgery, pregnancy, oral contraception) and genetic predisposition. For example, the G>A
mutation at position 1691 in the coagulation Factor V gene (FV Leiden - R506Q) was found with a
high frequency (20-60%) in patients with thrombosis. Other mutations in the Factor V gene, such as
the HR2 haplotype (H1299R) which involves the replacement of A>G at nucleotide 4070, results in
thrombosis especially if associated with the R506Q mutation. Point mutations in
methylenetetrahydrofolate reductase (MTHFR C677T and A1298C) and in the 3’-UTR region of the
prothrombin gene (Factor Il G20210A) have been associated respectively to a reduction in the
enzymatic activity of MTHFR and to a high prothrombin level in plasma. Each of these variants, in
association with the Leiden Factor V variant determines an increased risk related to venous
thromboembolism.

Among potential genetic markers of cardiovascular risk was also identified the PAI-1 (Plasminogen
Activation Inhibitor - type 1) gene that plays a critical role in the regulation of intravascular fibrinolysis.
The presence of a 4G sequence (instead of 5G) within the promoter region was associated with an
increased risk of venous thromboembolism.
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PRINCIPLE OF THE PROCEDURE

The test is based on the Real Time PCR technique in which the extracted DNA is amplified in the
presence of a probe complementary to the region that includes the mutation: the probe is labeled in
5' with a specific fluorophore while in 3' a quencher is bound. When the probe is not bound to the
DNA the fluorescence emitted by the fluorophore is dampened by the quencher: in the absence of
the target there is therefore no fluorescence emission. However, when the probe appears in the
DNA, the fluorophore is no longer damped by the quencher and, in the presence of a light source,
fluorescence is emitted at a specific wavelength. The probes allow to identify variants of the target
sequence by means of the dissociation curve (melting curve), subjecting the amplified to a rising
temperature ramp with consequent detachment of the probes from the DNA. If the probe is
complementary to the mutated DNA strand, the hybridization between the two will be more stable
than the duplex between the probe itself and the filament that does not carry the mutation (single
point mismatch), resulting in a peak of dissociation at a higher temperature . If, on the other hand, the
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probe is complementary to the filament that does not carry the mutation, the wild type peak will have
the peak of dissociation at the highest temperature.

By melting curve analysis, the three genotypes can therefore be distinguished based on the position
of the peaks: single peaks at two different temperatures for the homozygous (normal/mutated)
samples and double peak for the heterozygous ones.

The analysis includes two successive phases:

1. Genomic DNA extraction.

2. Amplification and detection of target sequences using Real Time PCR.
The regions of the MTHFR, FV, FIl and PAI-1 genes that comprise the respective mutations of
interest are co-amplified in a single Real Time PCR reaction using dedicated selected primers.

The individual variants are analyzed through the use of specific probes linked to different
fluorophores:

-  MTHFR C677T: the specific probe is linked to the FAM fluorophore
-  MTHFR A1298C.: the specific probe is linked to the JOE fluorophore
- PAI-14G/5G: the specific probe is linked to the CY5 fluorophore
- FV H1299R: the specific probe is linked to the CY5.5 fluorophore
- FV G1691A: the specific probe is linked to the ROX fluorophore
- FIl G20210A: the specific probe is linked to the ROX fluorophore

The CFX (BioRad) includes a thermocycler and a fluorescence detection device in a single
instrument. The computer connected to the system collects and displays the fluorescence data in the
graph shown in the manager instruments software. The data analysis is performed by the Real Gene
software (NLM code DO022).

PRODUCT COMPOSITION (store at -25/-15°C)

NO.

REAGENTS VOLUME VIALS
Mix 1 CVDB6, transparent cap 1ml 1
Mix 2 CVDS, blue cap >

: : - . 160 1 4
Oligonucleotides containing solution
Mix 3 CVD6, white cap 18 ul 1
DNA polymerase (5U/ul), orange cap 36 ul 1

STABILITY AND STORAGE

e All the reagents are stable up to the expiry date indicated on the label when stored at the correct
temperature (-25/-15°C).

e Thaw Amplification Mix on ice or at +2/+8°C

e Probes containing in the Mix 2 CVD6 tube are photosensitive: avoid direct and prolonged
exposure to light

e Master Mix have to be used immediately after preparation; once dispensed in PCR tubes, the
remaining reagents have to be discarded. Avoid prolonged exposure to light.

o Keep amplification reagents in ice during the entire procedure.

¢ At the end of each assay store reagents back at their correct storage temperature.
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PRECAUTIONS

The procedure should be performed by qualified personnel according to Good Laboratory
Practices and using usual personal protective equipment.

Use filter tips to avoid pipettes contamination.

Discard the disposable material used, gloves and all reagents used as bio hazardous waste.

Do not eat, drink, smoke or apply cosmetics in areas where reagents or specimens are handled.

If skin or mucous membrane exposure occurs, immediately wash the area with copious amount of
water. Seek medical advice.

Do not use components after expiration date.

Do not mix reagents from different lots.

Reagents have to be preserved from possible contaminants (as DNA samples and amplification
products)

Avoid repeated freezing and thawing of the mix.

It is recommended to make analysis in three different areas:

Area 1: pre-PCR (samples handling and extraction)

Area 2: Master Mix preparation.

Area 3: post-PCR (Real Time PCR)

Do not use the device if box is damaged; contact the supplier.

It is advisable to have constant and uniform laboratory temperature, avoid to place the
instruments near heating/cooling sources that may compromise the correct work.

MATERIALS REQUIRED BUT NOT SUPPLIED
ZONE 1

DNA Extraction Kit

Vertical downflow airbox

Dedicated adjustable volume pipettes set
Filtered pipette tips and disposable tubes

ZONE 2

Vertical downflow airbox

Dedicated adjustable volume pipettes set
Filtered pipette tips

0,2 ml Real Time PCR strips or plates

ZONE 3

Real Time Thermal cycler Instrument: 5 channel CFX BioRad instrument with manager software.
Real Gene interpretive software (code NLM DO022).

14
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PROCEDURE
DNA EXTRACTION

Extraction kit to be used: NLM code AA1001 (manual column based extraction) or AA1319/96
(automatic extraction with Janus - Perkin Elmer). Both automatic extraction systems, Maxwell (NLM
code AA1038) and MagCore (NLM code AA1185) are also compatible.

Use only EDTA or Citrate as anticoagulants, not heparin. Use fresh or correctly stored (+2/+8°C for
up to 2 days or -25/-15°C for longer periods) blood samples.

AMPLIFICATION

Warning:

e Avoid using repeated freeze/thaw cycles or not correctly stored blood and/or isolated DNA
samples in order to prevent bad assay results.

e Use dedicated Real Time PCR disposable tubes only

e We recommend to set the thermal profile before the amplification mix preparation.

o Keep tubes and all reagents for amplification on ice during execution of the whole procedure.

Prepare the master mix as follows:

Reagents Volume/sample
Mix 1 CVD6, transparent cap 18,8 ul
Mix 2 CVD86, blue cap 2,85 ul
Mix 3 CVD6, white cap 0,25 ul
DNA polymerase, orange cap 0,6 ul

o Prepare the Master Mix for the number of samples extracted +1 volume (for no. < 10) or +2
volumes (for no. > 10).

e Mix gently and dispense 22.5 ul of Master Mix in the previously marked 0,2 ml strip test tubes.
Discard the remaining Master Mix .

e Add 2.5 pl of respective isolated DNA to each tube (the DNA concentration to be used in this
test should be 20-60 ng/ul).
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RUN SET UP

Turn on the PC and the Real Time instrument

Open the "Bio-Rad CFX Manager Software" program and select "Create new run". Select the
instrument model used from the window and click "OK"; the "Run Setup" will be displayed.

It is possible to create a new protocol or select/modify a pre-existing one

To repeat a run: open the desired run and click on "File - Repeat Run"

Creating new protocol

“File > New Protocol”

The “Protocol Editor — new” window will be open

Enter the reaction volume (25 ul) in the “Sample Volume” box

Use "Insert Step" on the left of the window to enter the following thermal profile (you can change
temperatures and times directly on the chart or in the text written below by double click):

1 25,0° C for 10:00 min
2 95,0° C for 2:00 min
3 95,0° C for 0:15 sec
4 60,0° C for 0:50 sec
5 GOTO 3, 44 more times
6 95,0° C for 00:45 sec
7 37,0° C for 00:30 sec
8 Melt Curve 37,0 to 75,0° C, increment 0,5° C
for 0:05 sec + Plate Read
END
1 25,0 C for 10:00
P 5.0 C for 200
— 3 850 C for 015
4 600 C for 0:RO
— 5 GOTO 3, 44 moretmes
& 550 C for 0:45
7 370 C for 0:30
g MeltCurve 370 to 750 C, increment 05 C,

for 0:05 + Flate Read
EMD

Click OK. Save the new protocol.

PLATE SET UP

Select "plate" in the "Run setup" window: it is possible to create a new plate or select/modify a pre-
existing one.

Creating a new plate

“File = New Plate”

The "Plate Editor - new" window will be open

In "Scan Mode" select "All channels"

Click "Select Fluorophores" and select FAM, JOE, ROX, Cy5, Cy5.5

Select the plate wells where the samples will be placed.

Select in "Sample Type -2 Unknown”

Select "Target Name" and check the "Load" box to insert the fluorophores. Name the targets
exactly as shown in Table 1
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Target Fluorophore
Ce77T FAM
A1298C JOE
FV Leiden e FlI ROX
PAI-1 4G/5G Cy5
FV HR2 Cy5.5

Table 1. Target Name settings

Select one plate position at a time and enter the sample name in the "Sample Name" field; then
check the "Load" box
Click "OK". Save the new plate (Figure 1)

File  Settings Editing Tools ?
100% = || (8 Scan Mode | All Channels &) Well Groups... (] Trace Styles... | =1 Spreadshest View/Importer [\ﬂ_{] Plate Loading Guide
d 2 3 o i & Z & 2 i i el | !.J; Select Fuorophores. .. |
i Sample Type W
Load Target Name
V| FAM Ce77T -
B 9] joe A1298C -
V| ROX FVleidene F
Unk Unk Unk Unk Unk Unk
O677T Ce77T Ce77T Ce77T Q677T O677T vl Cys FAF4G/SG ~
B A1Z3EC A1Z38C A135EC ALT3EC A123EC A1Z3EC 7] Cy55 FVHR2 -
PAI-14G/5G PAI-1 4G(5G PAI-14G[5G PAI-14G[5G PAI-14G/5G PAI-14G/5G
PV HR2 FV HR2 FV HRZ FV HRZ FV HRZ PV HR2
A B c D E F Load Sample Name
Fl F -

Load Replicate #
1

| Replicate Series |

ﬁﬂ Experment Settings |

[ &
| )§ Clear Replicate # |
r |Jﬂ Clear Wells |

Exclude Wells in Analysis

Figure 1. Set-up of the plate

PROTOCOL OR EXISTING PLATE SELECTION AND MODIFICATION

To import a previously saved thermal profile (*.prcl) or plate(*.pltd) from the PC, select “File = Open
Protocol” or “File = Open Plate" respectively. It is possible to modify the recalled protocol or plate
and save the performed changes.

STARTING RUN

Select "Start Run" in the "Run Setup” window. The instrument is ready to start the run.

Prepare the plate/strip with samples and mix.

Open the lid, place the plate/strip in the instrument and close it.

Select "Start Run" to start.

Do not change the default name by which the run is saved by the CFX. The information contained
is necessary for the traceability of the run as it reports the date and start time of analysis.
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DATA ANALYSIS

- At the end of the run the "Data Analysis" window will open automatically.
- Select "Melt Curve": a new window shows the displayed charts of the run. The chart on the left
shows the raw data of the melting curve (RFU), the chart on the right shows the -d(RFU)/dT
analysis with the peaks of the melting curves.

- Select “Peak Type - Positive”
Set the correct threshold manually for each individual factor to eliminate background noise and/or

any non specific peaks (ref. 2a and 2b Figueres).
- Select "Melt Curve Data" and analyze the melting peaks obtained for each sample using the

following Table.

Target Tm1 Tm 2 Tm 1+ Tm 2
Fluorophore
Factor
[°’C] | [°C] Genotype [°C] [°C] Genotype Genotype
Fll . Homozygous
G20210A ROX 63 | =2 Wildtype | 68.5 | %2 mutated Heterozygous
FV Leiden . Homozygous
G1691A ROX 48 | =2 Wildtype | 56.5 | *2 mutated Heterozygous
Fv ; Homozygous
H1299R CY55 48 | =2 Wild type 59 | %2 mutated Heterozygous
MTHFR ' Homozygous
C677T FAM 60 | #2 Wwild type 51 +2 mutated Heterozygous
MTHFR . Homozygous
A1298C JOE 48 | 2 Wildtype | 57.5 | =2 mutated Heterozygous
PAI-1 Homozygous Homozygous Heterozygous
(4G/5G) cYs 58 | *2 4G 64 | +2 5G 4G/5G

Table 2. Interpretative table for sample genotyping

—> WARNING

To change the Threshold manually, click on the Melt Peak chart and move the threshold to remove

background signal.

Melt Peak

=]

wso Lo ]

100 +

50 ;.

-d(RFU)/dT

-d(RFU)IAT

50

I
60

Temperature, Celsius

I
70

Figure 2a. Graph for Factor V H1299R
with threshold set manually to eliminate
background signal.

For reporting, use the RealGene software (NLM code DO022).

=]

Melt Peak

/f\ ﬁ

!
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Temperature, Celsius

Figure 2b. Graph for MTHFR C677T with
threshold set manually to eliminate
background signal.
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PERFORMANCE CHARACTERISTICS

Analytical Sensitivity

The analytical sensitivity of the “CVD6 Multiplex Real Time” kit, expressed as the minimum quantity
of the target that can be detected (probability >99%), is 1 ng/ul of DNA (equivalent to 2.5 ng/reaction)
and was evaluated by testing serial DNA dilutions of three different samples, extracted with NLM
code AA1001 and run following instructions for use.

Diagnostic Sensitivity

The diagnostic sensitivity of the “CVD6 Multiplex Real Time” kit was assessed by analyzing 47
samples with a known genotype. All samples were correctly genotyped, resulting in a diagnostic
sensitivity of 100%.

Diagnostic Specificity

The specificity of the “CVD6 Multiplex Real Time” kit was determined by analyzing 47 samples with a
known genotype. No false positive results were obtained. In agreement with these data the specificity
of the kit is 100%.

Reproducibility

Intra-assay reproducibility

The intra-assay reproducibility was assessed by analyzing 3 different samples in 3 replicates in the
same run.

Inter-assay reproducibility
The inter-assay reproducibility was assessed by analyzing 3 different samples in different run ,
performed by different operators.

In agreement with the obtained results, reproducibility is 100%.
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